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NEW QUESTION 1
- (Exam Topic 1)
You need to add controls to the check-in solution for the health and wellness questions. Which form control should you use?

A. Drop down
B. Check box
C. Text input

Answer: A

NEW QUESTION 2
- (Exam Topic 1)
You need to design the resort portal's email registration process.
Which solutions should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 3
- (Exam Topic 2)
You need to set up the new service request completion process.
Which two components should you include in the solution? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. connection reference
B. business process flow
C. Power Automate flow
D. connection

Answer: AC

Explanation: 
Reference: https://docs.microsoft.com/en-us/power-apps/maker/data-platform/create-connection-reference 

NEW QUESTION 4
- (Exam Topic 2)
You need to implement the requirement for the VP of sales. What should you do?

A. Use a test account with a base security role with QV security added.
B. Add the System Administrator security role to your user account.
C. Use a test account with only QV security added.

Your Partner of IT Exam visit - https://www.exambible.com 



We recommend you to try the PREMIUM PL-200 Dumps From Exambible
https://www.exambible.com/PL-200-exam/ (211 Q&As)

D. Add QV security to your user account.

Answer: A

Explanation: 
A VP of sales requires a test environment to demonstrate to potential clients the security policies that are included in their initial offering.
Currently, testing the new QV functionality outside the development environment is not possible due to corporate security policies requiring the same security role
across all environments.
Note: One of the security best practices in Dynamics 365 is to use the base security role as a baseline and apply that role to all Users. The base security role will
include all the common/basic permissions that are required to have access to the system.
To set up the base security role for the first time

 create a new empty security role.

 add the minimum privileges required to access the system.

 add the privileges required for the basic functionalities.

 test the role with the test user account.

 add the permissions to the entities that all users can access (e.g. reference data).
Reference: https://linnzawwin.blogspot.com/2020/07/minimum-privileges-required-to-log-in.html 

NEW QUESTION 5
- (Exam Topic 2)
You need to configure a Power Automate flow to send the email with the results to the client. What should you use? To answer, select the appropriate options in
the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Set Table table to Qualification and Column filter to statuscode.
Box 2: Loop through related qualification records and complete if all are in Complete status. The new process for completing a service request must automate the
following:
Set the Service Request record status to Complete when work on all Qualification records is finished.
Send an email to the client with the results when the service request is completed. The email must list each qualification as either Valid or Not Valid, depending on
the verification.

NEW QUESTION 6
- (Exam Topic 2)
You need to add the missing components to the Verification Process Automation solution. Which two components should you add? Each correct answer presents
a complete solution. NOTE: Each correct selection is worth one point.

A. Service Request statuscode field
B. Dataverse connection reference
C. Qualification statuscode field
D. On-premises data gateway reference
E. Outlook connection reference

Answer: CE

Explanation: 
C: A service request can have one or more Qualification records associated with it. E: The new process for completing a service request must automate the
following:
• Set the Service Request record status to Complete when work on all Qualification records is finished.
• Send an email to the client with the results when the service request is completed. The email must list each qualification as either Valid or Not Valid, depending
on the verification.

NEW QUESTION 7
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- (Exam Topic 3)
You are a Dynamics 365 Customer Service system administrator.
Your organization does not permit the use of custom code for solutions. You need to create a view that can be viewed by all users in an organization. Where
should you create the view?

A. Microsoft Excel template
B. Entities component of a solution
C. Microsoft Virtual Studio
D. Templates area

Answer: B

Explanation: 
Entity: Refers to a table in Dataverse. Table and entity are often used interchangeably for data access. Edit public views through tables

Expand Data, select Tables, select the table you want, and then select the Views area.

 On the toolbar, select Add view. Add view to table

 On the Create a view dialog, enter a name and, optionally, a description, and then select Create. Reference:
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-edit-views-app-designer

NEW QUESTION 8
- (Exam Topic 3)
You are a consultant. A client asks you to remove several solutions in one of their Microsoft Dataverse environments
The client wants to know what effect removing the solutions will have on the rest of the system. You need to explain the results of removing the solutions.
Which components be affected? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated

NEW QUESTION 9
- (Exam Topic 3)
You modify a model-driven app for a bicycle repair help desk. The model-driven app is for help desk users when customers have an issue with their bicycle.
After you add a custom table named bicycle, you configure the table for Microsoft Dataverse search. The table will contain information from callers about their
bicycles. The account table is related to the custom table. Contact information is brought over to the custom table.
You add the following columns to the table:

 Bicycle type

 Tire brand

 Special equipment
Users must be able to perform the following types of searches:

 Search for all customers who have a bicycle type of Contoso and live in Florida.

 Search all tables for any record that contains the word broken.

 You need to decide which type of search will give you the results desired.
Which search should you configure? To answer, drag the appropriate search types to the correct requirements. Each search type may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Text Description automatically generated
Box 1: Advanced find
Operators for advanced search: Lets you use simple Boolean operators in your search term and craft the query to get the results you want.
Box 2: Dataverse search
Dataverse search helps you quickly find what you're looking for. It delivers fast and comprehensive results across multiple tables in a single list, sorted by
relevance.
Reference: https://docs.microsoft.com/en-us/power-apps/user/quick-find https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-
organization

NEW QUESTION 10
- (Exam Topic 3)
A company has a canvas app that includes the following screens: Screen1 and Screen2. The OnVisible property for Screen1 contains the following expression.
Set(AgeGroups, ["1-25", "26-54", "55+"])
For each of the following statements, select Yes if the statement is true. Otherwise, select No. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 10
- (Exam Topic 3)
You are modifying a model-driven app. You set up a customer table in Microsoft Power Platform to retrieve user data. You set up a form with the following columns
for users to enter their data. The form includes the following columns:
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The form must do the following:
• The Country/region column must automatically populate with US when English is chosen as a language. If the user selects Other for this column, the column
must remain blank so that user can enter a value.
• The Passport expiration date column must appear only if the user selects Yes in the Passport ownership column.
You need to configure the app with the least amount of effort.
What should you configure? To answer, drag the appropriate solution component to the correct requirements. Each solution component may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface Description automatically generated with low confidence

NEW QUESTION 14
- (Exam Topic 3)
You create a new Power Virtual Agents chatbot for an organization. Testing and production deployment of the chatbot are not complete. You need to ensure that
appropriate users can access the chatbot.
Which methods should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, application Description automatically generated
Box 1: Use the demo website
When publishing the bot to the web, you can publish to a prebuilt demo website (which you can use to share the bot with your teammates and stakeholders) and to
your own live website.
Box 2: Share the chatbot to a security group containing all users.
A license for each user, also known as a "per user license" (or "Power Virtual Agent User License" as referred
to on the Microsoft 365 admin center), should be assigned to individual users who need access to create and manage chatbots.
To simplify user license management, you can assign licenses to an Azure Active Directory (Azure AD) security group.
Box 3: Embed the chatbot code in an IFRame on your copany's public website
You can add your bot to a live website as an IFrame. Your live website can be a customer-facing external website or an internal site, like a SharePoint or Yammer
site.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/publication-connect-bot-to-web-channels https://docs.microsoft.com/en-us/power-virtual-
agents/requirements-licensing

NEW QUESTION 19
- (Exam Topic 3)
A company uses a canvas app.
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Supervisors must approve transactions when a user from the sales department enters a revenue amount that is over $1 million.
You need to configure an approval process without using code. What should you create?

A. Column Expression
B. Power Automate cloud flow
C. Azure Service Bus service
D. Power Apps component framework (PCF) control

Answer: B

NEW QUESTION 22
- (Exam Topic 3)
You are examining several processes to determine if you can automate the processes by using Power Automate.
The processes must run without human intervention when possible.
You need to determine which flow type should be used for each process.
Which flow type should you use? To answer, drag the appropriate processes to the correct flow types. Each process may be used once, more than once, or not at
all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Text Description automatically generated
Box 1: Attended desktop flow
Desktop flows are used to automate tasks on the Web or the desktop.
To run an attended desktop flow, you need to have an active Windows user session that matches the name of the user configured for your connection.
Note: Web applications are critical components of most organizations, and they are commonly used to access data from servers.
Most CRM and ERP platforms run through web browsers, while the most popular business productivity tools are web services. Web applications are
unquestionably an integral part of the technological infrastructure of most companies.
To provide automation solutions for these applications, Power Automate Desktop supports all major browsers through its web automation actions.
Box 2: Unattended desktop flow.
Unattended desktop flows are best for applications that do not need human supervision. References:
https://docs.microsoft.com/en-us/learn/modules/pad-web/1-introduction
https://docs.microsoft.com/en-us/power-automate/desktop-flows/run-pad-flow

NEW QUESTION 24
- (Exam Topic 3)
A company is training an Al model using a custom table to determine the amount of time it takes to deliver a package based on several key fields.
The testing data used to train the model is used for all training and regression testing scenarios and is considered complete data.
The trained model predicts a 2 percent variance between the estimated delivery time and the actual delivery time of packages.
The executive sponsors reject the model because the actual variance is at 15 percent. You need to address the sponsors' concern
What should you do?

A. Reduce the size of the data used within the model.
B. increase the size of the data used with the model.
C. Use sample training data from Microsoft
D. Replace the training data with real-world data.

Answer: D

Explanation: 
Note: Start using AI Builder with sample data
Don't have any data of your own to create a model? No problem! We've got you covered.
Sample data is available for several AI Builder model types, together with instructions for working with the sample data.
Reference: https://docs.microsoft.com/en-us/ai-builder/samples

NEW QUESTION 28
- (Exam Topic 3)
You need to design the FAQ solution to handle unknown responses.
Which component should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-hand-off

NEW QUESTION 33
- (Exam Topic 3)
You create a new independent software vendor (ISV) solution for a Power Apps app.
The Power Apps solution will be imported into multiple customer environments. The environments will have a large variety of solutions and publishers.
You need to avoid naming conflicts during solution import.
Which element should you configure?

A. Package type
B. Configuration page
C. Marketplace
D. Prefix
E. Version

Answer: D

Explanation: 
A solution publisher includes a prefix. The publisher prefix is a mechanism to help avoid naming collisions. This allows for solutions from different publishers to be
installed in an environment with few conflicts. For example, the Contoso solution displayed here includes a solution publisher prefix of contoso.
Reference: https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm

NEW QUESTION 36
- (Exam Topic 3)
You are a system administrator for a company with locations in Mexico, United States, and France. The company has both fulltime employees and contractors in
all regions. Fulltime employees use a mobile app. The company has two security groups: fulltime employees and contractors.
The company requests a chatbot in Microsoft Teams to answer employee benefit questions. The chatbot must meet the following requirements:
• It must be in the local language.
• Only fulltime employees may access the chatbot. You need to configure the chatbot.
Which action should you perform? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 37
- (Exam Topic 3)
You are creating a business rule to implement new business logic.
You must apply the business logic to a canvas app that has a single screen named Screen1. You need to configure the scope for the business rule.
Which scope should you use?

A. All Forms
B. Entity
C. Screen1
D. Global

Answer: B

Explanation: 
Note: Some terminology has changed. Entity is now Table. If you're building a Canvas app, you must use table (entity) as the scope.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-business-rule

NEW QUESTION 38
- (Exam Topic 3)
A company uses a model driven app.
The company needs to automatically update the Status column in real time. You need to configure this feature.
Solution: Create a workflow that has a Change Status step. Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 43
- (Exam Topic 3)
You are using a development environment to add a new column to a system table. You plan to move the changes to a test environment they are complete.
The changes must meet the following requirements:
• Must be clearly identified so that they are not confused with system components and components from other solutions.
• Must not affect any existing components in the test environment. You need to prepare a solution for deployment to the test environment.
Which four actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Step 1: Create a new publisher Solution publisher
Every app and other solution components such as entities you create or any customization you make is part of a solution. Because every solution has a publisher,
you should create your own publisher rather than use the default. You specify the publisher when you create a solution.
Step 2: Create a new unmanaged solution and select the correct publisher unmanaged solution
Unmanaged solutions are used in development environments while you make changes to your application. Unmanaged solutions can be exported either as
unmanaged or managed. Exported unmanaged versions of your solutions should be checked into your source control system. Unmanaged solutions should be
considered your source for Microsoft Power Platform assets. When an unmanaged solution is deleted, only the solution container of any customizations included in
it is deleted. All the unmanaged customizations remain in effect and belong to the default solution.
Step 3: Add the table top the solution and add the new column. Step 4: Run the solution checker on the solution
Use solution checker to validate your model-driven apps in Power Apps.
Reference: https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm https://docs.microsoft.com/en-us/power-apps/maker/data-platform/use-
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powerapps-checker

NEW QUESTION 46
- (Exam Topic 3)
A company uses a Power Apps app with Microsoft Dataverse.
The company requires the import of records into Dataverse. Duplicate records in the data must be deleted without user intervention.
You create a duplicate detection rule.
You need to configure the rule for the data import. Which option should you configure?

A. Enable the Templates for Data Import option.
B. Enable the When a record is created or updated option.
C. Disable the Allow Duplicates option.
D. Enable the During data import option.

Answer: D

Explanation: 
When configuring a duplicate detection rule in Power Apps with Microsoft Dataverse, to automatically delete duplicate records during a data import, you should
enable the "During data import" option. This option allows the detection rule to automatically delete duplicates as they are imported into the system, without
requiring user intervention.
References:

 https://docs.microsoft.com/en-us/power-platform/admin/create-duplicate-detection-rule

 https://docs.microsoft.com/en-us/power-platform/admin/data-integration-duplicate-detection 

NEW QUESTION 49
- (Exam Topic 3)
A company uses Common Data Service to store sales data.
For the past few quarters, the company has experienced a decrease in sales revenue. The company wants to improve sales forecasting.
The company plans to use Al Builder to implement the solution. You select fields that will be used for prediction.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, application Description automatically generated
Step 1:
Before you can use your prediction model, you have to train it to perform the way you want. Step 2:
After you train your model, publish it to make it available.
Publish your model when you want to make it available to users in your Power Apps environment. Step 3: Use the model with Power Apps
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Reference:
https://docs.microsoft.com/en-us/ai-builder/prediction-train-model

NEW QUESTION 51
- (Exam Topic 3)
You are a Dynamics 365 administrator. You create a new app.
You need to create the site map for the app.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 53
- (Exam Topic 3)
You plan to create a canvas app.
The app must meet the following requirements:
• Send an email after a record is saved.
• Display the expiration column on a form if the creation date of the record is older than 90 days. You need to configure the app.
Which features should you use? To answer, select the appropriate options in the answer area.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 54
- (Exam Topic 3)
A customer uses Power Apps to view and maintain their contacts that are stored in Microsoft Dataverse. Several columns must be configured to ensure the
security settings for sales associates are view only. You need to configure the access restrictions.
Which component for field-level security should you use? TO answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated

NEW QUESTION 58
- (Exam Topic 3)
You are a Dynamics 365 Sales administrator for a software company. The sales team wants to attach a large number of supporting documents to customer
records, but management does not want to incur the cost of additional storage.
The company does not have any Office 365 application integrations enabled. You need to recommend a storage solution that keeps storage costs low. Solution:
Enable OneNote integration.
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Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 62
- (Exam Topic 3)
You plan to create user interface (Ul) flows to automate several web-based business processes that you currently perform manually. You need to ensure that
users can create and run web Ul flows.
Which three components must you install and configure on user's devices? Each correct answer presents part of the solution. NOTE Each correct selection is
worth one point.

A. Ul Flows application
B. Selenium IDE
C. Latest version of Microsoft Edge
D. On-premises data gateway
E. Latest version of Mozilla Firefox

Answer: ABC

Explanation: 

Reference:
https://docs.microsoft.com/en-us/power-automate/ui-flows/setup

NEW QUESTION 65
- (Exam Topic 3)
A company is updating a Power Apps solution that contains two tables named Sen/ices and Equipment. The company is creating a new solution to update the
current solution for the following requirements:
• The Services table must be updated to include change tracking.
• The Equipment table must be updated to include four new columns.
• The solution must update only the components that need to be added or changed. You need to create the solution.
Which table option should you use? To answer, drag the appropriate options to the correct tables. Each option may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Select components Option for Services Table Select components Option for Equipment Table
The "Select components" table option allows you to update specific components of a table, such as adding new columns or change tracking, while keeping the
existing data and relationships in the table intact. This meets the requirement that the solution must update only the components that need to be added or
changed.
You can use the Power Apps maker portal and navigate to the Environment, then click on the Data tab, select the table you want to update and click on the
settings icon and then select "Select components" from the options. Then you can select only the columns you want to add or update for each table.
This way, you can ensure that the solution will update only the necessary components for each table, including change tracking for the Services table and four new
columns for the Equipment table, without affecting the existing data and relationships in the tables.

NEW QUESTION 70
- (Exam Topic 3)
You are configuring a new Power Apps portal. You have two web roles, one for authenticated users and one for anonymous users. You grant the Anonymous
Users role to users.
A test user reports that they can access the home page but cannot view a page linked from the home page. You need to determine why the test user cannot view
the portal page.
What is the cause of the issue?

A. Maintenance mode is enabled on the portal.
B. The setting to make the page available to everyone is disabled.
C. The Authenticated Users Web role does not have permission to view the page.
D. Inherited permissions are not enabled for the linked page.

Answer: D

Explanation: 
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https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/webpage-access-control 

NEW QUESTION 71
- (Exam Topic 3)
A Company plans to send escalation emails to all customers with overdue invoices. You are creating a Microsoft Power Automate flow to determine whether to
send an escalation email.
The system must send an alert for all invoices that are seven days or more overdue. You need to configure the flow.
Which expression should you use?

A. Option A
B. Option B
C. Option C

Answer: C

Explanation: 
Example: equals(triggerOutputs()?[‘body/PDFStatus/Value’],’Ready to Generate’) Reference:
https://evolvous.com/microsoft-power-automate-trigger-condition/

NEW QUESTION 73
- (Exam Topic 3)
The owner of a company needs to know who signs into the system. You need to ensure that the owner can view the user audit logs.
Where does each action need to be performed? To answer, select the appropriate options in the answer area. NOTE Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/audit-data-user-activity

NEW QUESTION 75
- (Exam Topic 3)
You make the following customizations to a Microsoft Dataverse Environment
• Create a new table
• Add data to the new table.
• Delete an unused area from the site map.
The components must be transported to a different environment.
You need to determine the method required to transport each component.
Which method should you use? To answer, drag the appropriate methods to the correct components. Each method may be used once, more than once, or not at
all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

Your Partner of IT Exam visit - https://www.exambible.com 



We recommend you to try the PREMIUM PL-200 Dumps From Exambible
https://www.exambible.com/PL-200-exam/ (211 Q&As)

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 78
- (Exam Topic 3)
You use Power BI Desktop to configure Power BI reports.
You need to create a canvas app that displays user account information and include the app in a Power BI
report.
Which three actions should you perform? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. From the Power Apps Insert menu, add a Power BI tile
B. From the Power BI Desktop menu, insert a Power Apps visual and include the required fields in the Power Apps data
C. Publish the report to the Power BI service
D. Connect to Common Data Service from Power BI Desktop

Answer: BCD

Explanation: 
Step 1 (B): Here’s how we embed PowerApps into a Power BI report:

 Download and login to the Power BI desktop application

 Click on (…) and select “Import from the marketplace.”
Step 2: Open Power BI desktop and use “Get data” to connect with the Common Data Service data source. Step 3: Publish the report to Power BI service.
Reference:
https://purple.telstra.com/blog/powerbi-integration-with-powerapps

NEW QUESTION 83
- (Exam Topic 3)
You implement an editable grid for the Account entity.
The business team provides the following list of features that they would like you to implement:

 Group by or sort columns in the current view.

 Configure a business rule to show an error message.

 Edit values in calculated fields.

 Edit the Address composite field.

 Use the editable grid on mobile phones.
Which actions can you perform? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 88
- (Exam Topic 3)
A company uses a model-driven app with Microsoft Dataverse in a single environment
The company requires a canvas app that includes the same data as the model-driven app. You need to create the canvas app.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A
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Explanation: 

NEW QUESTION 90
- (Exam Topic 3)
A company uses Power Apps.
The company plans to create a canvas app that uses a responsive design. You need to configure the app.
Which two actions should you perform? Each correct answer presents part of the solution. NOTE: Each correct selection is worth one point.

A. Enable the lock orientation setting.
B. Configure the height and width properties by using a formula.
C. Disable the Scale to fit setting.
D. Configure the height and width properties by using drag handles.

Answer: BC

Explanation: 
To create a canvas app that uses a responsive design in Power Apps, you should perform the following actions:
* B. Configure the height and width properties by using a formula: By using a formula to set the height and width properties, you can ensure that the app will
respond to changes in screen size and orientation. For example, you can use the Width() and Height() functions to set the width and height properties based on
the size of the screen.
* C. Disable the Scale to fit setting: The Scale to fit setting, when enabled, makes the app's content fit on the screen by scaling it down. To create a responsive
app, this setting must be disabled.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/responsive-design https://docs.microsoft.com/en-us/powerapps/maker/canvas-
apps/functions/function-width

NEW QUESTION 95
- (Exam Topic 3)
You are a Dynamics 365 Customer Engagement administrator. You create a new solution in Dynamics 365. You need to help end users understand which actions
to take next and ensure that user interaction occurs in manageable steps.
Which actions should you perform? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 98
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- (Exam Topic 3)
You are designing a chatbot for a sports outlet. You need to complete the chatbot.
Which features should you use? To answer, drag the appropriate features to the correct requirements. Each feature may be used once, more than once, or not at
all. You may need to drag the split bar between panes or scroll to view content.
NOTE Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated
Box 1: Entities
Out of the box, Power Virtual Agents comes with a set of prebuilt entities, which represent the most commonly used stereotype information in real-world dialogs,
such as age, colors, numbers, and names.
With the knowledge granted by entities, a bot can smartly recognize the relevant information from a user input and save it for later use.
Box 2: Topics
In Power Virtual Agents, a topic defines a how a bot conversation plays out.
You can author topics by customizing provided templates, create new topics from scratch, or get suggestions from existing help sites.
A topic has trigger phrases – these are phrases, keywords, or questions that a user is likely to type that is related to a specific issue – and conversation nodes –
these are what you use to define how a bot should respond and what it should do.
Box 3: Variables
Variables let you save responses from your customers in a conversation with your bot so that you can reuse them later in the conversation.
For example, you can save a customer's name in a variable called UserName. The bot can then address the customer by name as the conversation continues.
You can use variables to create logical expressions that dynamically route the customer down different conversation paths.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling https://docs.microsoft.com/en-us/power-virtual-agents/authoring-create-edit-
topics
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-flow https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables

NEW QUESTION 99
- (Exam Topic 3)
You are a Dynamics 365 Customer Service system administrator. You create an app for the sales team. Members of the sales team cannot access the app.
You need to ensure that sales team members can access the app. Where should you configure app permissions?

A. Security Roles
B. Manage Roles
C. Dynamics administration center
D. Dynamics 365 home

Answer: B

Explanation: 
 References:
https://docs.microsoft.com/en-us/dynamics365/customer-engagement/customize/manage-access-apps-security-r Manage access to apps by using security roles.
You can choose what users see and access from the My Apps page or the Customer Engagement home page by giving app access to specific security roles.
Users will have access to apps based on the security roles they're assigned to.
* 1. Go to Settings > My Apps.
* 2. In the lower-right corner of the app tile you want to manage access for, select More options (...), and then select Manage Roles.
* 3. Enter the following in the Manage Roles dialog box:
a) App URL Suffix
b) Roles
c) Select Save.
* 4. Refresh the My Apps page.
* 5. Go to the Apps Being Edited view, and publish the app again. Reference:
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-app

NEW QUESTION 104
- (Exam Topic 3)
You plan to add a Power Apps app to Microsoft Teams.
A Microsoft Dataverse for Teams environment has not been provisioned. You need to create a Dataverse for Teams environment.
Which two actions can you perform? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.
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A. Create a new environment in the Microsoft Power Platform Admin Center.
B. Create a new app in Teams.
C. Create an app permission policy in the Teams admin center.
D. Install an existing app in Teams.

Answer: BD

NEW QUESTION 107
- (Exam Topic 3)
You are designing a canvas app that connects to Common Data Service.
You need to configure the app to meet the requirements and ensure that the canvas app is available offline. What should you implement? To answer, select the
appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/offline-apps

NEW QUESTION 111
- (Exam Topic 3)
You need to create a Power Automate desktop flow.
What are two possible ways to create the flow? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Record mouse and keyboard events.
B. Configure a pre-built template.
C. Use pre-built actions.
D. Create models by using Microsoft Visio.

Answer: AC

Explanation: 
C: Desktop flows are used to automate tasks on the Web or the desktop. Using Power Automate you can automate tasks on the desktop as well as the Web.
A: Alternatively, you can use the two legacy methods of creating desktop flows: Windows recorder (V1) and Selenium ID. With these you record mouse and
keyboard events.
Reference:
https://docs.microsoft.com/en-us/power-automate/desktop-flows/create-flow https://docs.microsoft.com/en-us/power-automate/desktop-flows/create-web

NEW QUESTION 113
- (Exam Topic 3)
You use Power Bl Desktop to configure Power Bl reports and dashboards.
You need to create a canvas app that displays account information and include the app in a Power Bl report. Which three actions should you perform? Each
correct answer presents part of the solution.
NOTE Each correct selection is worth one point.

A. Publish the report to the Power Bl service.
B. Connect to Common Data Service from Power Bl Desktop.
C. Connect Common Data Service from Power Bl Deskto
D. Selected required fields from the Accounts table.
E. From the Power Apps Insert menu, add a Power Bl
F. From the Power Bl Desktop menu, insert a Power Apps visual and include the required fields in the Power Apps data.

Answer: CDE

NEW QUESTION 117
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- (Exam Topic 3)
You create workflows to automate business processes.
You need to create a workflow that automatically sends emails based on a mail merge template. The workflow must contain the following configurations:

 Run immediately.

 Validate when a condition is met.

 Perform an action when a condition is met.
To answer, select the appropriate configuration in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated

NEW QUESTION 119
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer
interactions with employees. The app uses standard table types for customers. A user named Elisabeth Rice signs in to the app by using the following sign in
name: Elisabeth.Rice@contoso.com.
After marriage, Elisabeth changes her legal name to Elisabeth Mueller.
You need to update the sign in name for the user without losing any application history.
Solution: From Dynamics 365 Settings, select Email Configuration. In the active mailbox for the user, update the name.
Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Change the user name, not the email configuration. Change a user's email address
You must be a global admin to complete these steps.

 In the admin center, go to the Users > Active users page.

 Select the user's name, and then on the Account tab select Manage username.

 In the first box, type the first part of the new email address. If you added your own domain to Microsoft 365, choose the domain for the new email alias by using
the drop-down list. Learn how to add a domain.

 Select Save changes. Reference:
https://docs.microsoft.com/en-us/microsoft-365/admin/add-users/change-a-user-name-and-email-address

NEW QUESTION 122
- (Exam Topic 3)
You are creating a canvas app.
A user will click a button on each screen of a Power Apps app to proceed to the next screen. You need to implement an action that selects the next screen that the
user sees.
Which event should you handle?

Your Partner of IT Exam visit - https://www.exambible.com 



We recommend you to try the PREMIUM PL-200 Dumps From Exambible
https://www.exambible.com/PL-200-exam/ (211 Q&As)

A. OnLoad
B. OnCheck
C. ScreenTransition
D. OnSelect

Answer: D

Explanation: 
 Add navigation
* 1. With the Source screen selected, open the Insert tab, select Icons, and then select Next arrow.
* 2. With the arrow still selected, select the Action tab, and then select Navigate.
* 3. The OnSelect property for the arrow is automatically set to a Navigate function.

* 4. When a user selects the arrow, the Target screen fades in.
* 5. On the Target screen, add a Back arrow, and set its OnSelect property to this formula:
* 6. Navigate(Source, ScreenTransition.Fade)
* 7. While holding down the Alt key, toggle between screens by selecting the arrow on each screen. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables

NEW QUESTION 124
- (Exam Topic 3)
You create a Power Virtual Agents bot.
You observe that the bot is not able to recognize input from some users. You need to configure the bot response for unrecognized input from users.
What are two possible ways to achieve this goal? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. Transfer to an agent.
B. Use a fallback topic.
C. Display a system-defined error message.
D. Connect to a different channel.

Answer: BC

Explanation: 
* B. Use a fallback topic: Power Virtual Agents provides the capability to handle unrecognized inputs by using fallback topics. A fallback topic is a topic that is
triggered when the bot is unable to recognize the user input. You can configure fallback topics by going to the Power Virtual Agents portal, and then select the bot
you want to configure. Then select the "Topics" tab and create a new topic with a fallback trigger. Reference: https://docs.microsoft.com/en-us/power-virtual-
agents/topics-triggers#fallback-triggers
* C. Display a system-defined error message: This is another option to handle unrecognized inputs by displaying a predefined message that inform the user that
the bot was unable to understand their input.

NEW QUESTION 129
- (Exam Topic 3)
You create a Power Apps portal to provide training and documentation for students. Students create a profile on the portal and then select and pay for courses.
You plan to add free courses to the training portfolio. Free courses must be automatically available to all students when they sign in.
You need to assign default permissions to students. What should you do?

A. Create an entity for managing free course
B. Create a Students web role and set the Authenticated Users role option to tru
C. Create appropriate entity permissions to access the free course entity records and assign the entity permissions to the web role.
D. Create an entity for managing free course
E. Create entity permission records to provide access to entity records for free courses and assign the entity permissions to users when they register on the portal
for the first time.
F. Create a Students web role and set the Authenticated Users Role option to tru
G. Assign the web role to each registered user.

Answer: C

NEW QUESTION 134
- (Exam Topic 3)
You create a report by using Power Bl Desktop and publish the report to the Power Bl service. You enable Power Bl visualization embedding in a model-driven
app.
You need to configure the model-driven app to display a Power Bi tile
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
1) Pin the Power BI report to a new dashboard in the Power BI service
2) Create a personal dashboard in the model-driven app (as Power BI dashboards are always personal dashboards (that can be shared))
3) Add a power BI tile to the dashboard and select the Power BI dashboard in the app.

NEW QUESTION 137
- (Exam Topic 3)
On a Contact record, a user creates a Note record that contains the word running.
One week later, the user reports that they cannot find the Contact record associated with the Note record. You need to find the Note record.
Solution: Use Quick Find search on the Notes list to search for the word run. Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Instead use Relevance Search.
Note: Relevance Search finds matches to any word in the search term in any field in the entity. Matches may include inflectional words, like "stream," "streaming,"
or "streamed."
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-releva

NEW QUESTION 141
- (Exam Topic 3)
You need to embed the FAQbot into the communication solution.
Which actions should you perform? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A
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Explanation: 

NEW QUESTION 143
- (Exam Topic 3)
A company uses a model-driven app. The app uses a Power Virtual Agents chatbot.
The company has two locations in different countries/regions with separate environments for each location. Each location has a development environment, a
testing environment, and a production environment. The company uses the Application Lifecycle Management (ALM) process for the environments.
You need to create the different Power Virtual Agents bot environments. How many Power Virtual Agents bot environments are required?

A. 1
B. 2
C. 3
D. 6

Answer: D

Explanation: 
When a company uses a model-driven app that incorporates a Power Virtual Agents chatbot, and has multiple locations with different environments for each
location, it is necessary to create separate Power Virtual Agents bot environments for each location.
For each location, 3 different environments are required: development, testing, and production. This is in line with the Application Lifecycle Management (ALM)
process that the company uses.
In total, 6 Power Virtual Agents bot environments are required: 2 locations x 3 environments per location = 6. It's worth mentioning that Power Virtual Agents allows
to export and import the bot, so once you configure the bot in one environment, you can import the bot to the other environments, this way you don't need to start
from scratch.
References:

 https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/bot-lifecycle

 https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/export-import

NEW QUESTION 144
- (Exam Topic 3)
You are creating a new business process flow to qualify leads.
You create an action. The action is not available inside the Action Step. You need to make the action available to the Action Step.
Which two steps must you perform? Each correct answer presents part of the solution. NOTE: Each correct selection is worth one point.

A. Activate the action.
B. Select Run as an on-demand process
C. Add at least one step to the action.
D. Ensure that the entity for the action matches the corresponding entity for the business process flow stage.

Answer: CD

Explanation: 
Reference:
https://docs.microsoft.com/en-us/business-applications-release-notes/april18/microsoft-flow/add-action-business

NEW QUESTION 149
- (Exam Topic 3)
You plan to create a Power Bi dataflow.
The Power BI dataflow has the following requirements:
• Be able to create a copy of the dataflow to separate Power Bl workspaces
• Schedule the dataflow to update every day at 11:00 AW. You need to configure the dataflow.
What should you do? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 151
- (Exam Topic 3)
You need to create a system chart for the Account entity.
The chart must display a count of accounts grouped by owner and then display the accounts by Address 1: State/Province for each owner. You begin to configure
chart options as shown in the image below.
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How should you complete the configuration? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point. The chart must display a count of accounts grouped by owner, and then display the accounts by Address 1 to
State/Province for each owner.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 153
- (Exam Topic 3)
You are configuring Microsoft Dataverse security. You plan to assign users to teams. Record ownership and permissions will differ based on business
requirements.
You need to determine which team types meet the requirements.
Which team type should you use? To answer, drag the appropriate team types to the correct requirements.
Each team type may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Microsoft Teams team
Dataverse supports two types of record ownership. Organization owned, and User or Team owned. This is a choice that happens at the time the table is created
and can’t be changed. For security purposes, records that are organization owned, the only access level choices is either the user can do the operation or can’t.
For user and team owned records, the access level choices for most privileges are tiered Organization, Business Unit, Business Unit and Child Business Unit or
only the user’s own records. That means for read privilege on contact, I could set user owned, and the user would only see their own records.
Box 2: Access team
An access team doesn’t own records and doesn’t have security roles assigned to the team. The team members have privileges defined by their individual security
roles and by roles from the teams in which they are members. The records are shared with an access team and the team is granted access rights on the records,
such as Read, Write or Append.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/wp-security-cds
https://docs.microsoft.com/en-us/powerapps/developer/data-platform/use-access-teams-owner-teams-collaborate

NEW QUESTION 154
- (Exam Topic 3)
You create functionality for a company. The functionality includes a Microsoft Dataverse table with a form for data entry. The functionality will be distributed to other
lines of business in the company, each with its own Dataverse environment.
New forms must not be created in order for updates to the functionality to work correctly. You need to package the new functionality for distribution.
What should you do?

Your Partner of IT Exam visit - https://www.exambible.com 



We recommend you to try the PREMIUM PL-200 Dumps From Exambible
https://www.exambible.com/PL-200-exam/ (211 Q&As)

A. Use a patch solution and disable the ability to create new forms for the table.
B. Use a managed solution and include only the needed form.
C. Use an unmanaged solution and include only the needed form.
D. Use a managed solution and disable the ability to create new forms for the table.

Answer: B

Explanation: 
Managed solutions are used to deploy to any environment that isn't a development environment for that solution. This includes test, UAT, SIT, and production
environments. Managed solutions can be serviced independently from other managed solutions in an environment. As an ALM best practice, managed solutions
should be generated by exporting an unmanaged solution as managed and considered a build artifact. Additionally:
You can't edit components directly within a managed solution.
Reference: https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm

NEW QUESTION 156
- (Exam Topic 3)
A customer tracks events by using a custom entity.
The custom entity includes a custom field for the venue of the events. The customer must be able to display the events by venue in a calendar.
You need to ensure that all events display by venue in the calendar. To which component should you add a control?

A. Form
B. view
C. Field
D. Chart

Answer: B

Explanation: 
If you use unified interface, you can display any record in a calendar view via the calendar control.

 Go to Settings->Customization->Customize the System

 Open the configuration for the entity that you want to use the calendar control (Opportunities in our example)

 Click the View tab

 Click “Add Control” and select the calendar control.

 Click the dot for every interface from which you want the calendar control to be available.
Reference:
https://crmtipoftheday.com/1206/view-any-dynamics-365-record-on-a-calendar/

NEW QUESTION 160
- (Exam Topic 3)
You need to recommend a role for users to perform several required tasks. The solution must use the principle of least privilege.
Which roles should you recommend? To answer, drag the appropriate roles to the correct functions. Each role may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated
Box 1: Office 365 Global Administrator
You may think that the Dynamics 365 system administrator would have power to do all the actions needed to manage Dynamics 365, but this is not the case.
What's different in Microsoft cloud deployments is that licenses and user accounts are managed in Office 365 by an Office 365 Global Administrator. This role is
analogous to a network administrator for an on premises deployment. The Global Administrator is the only role to create new user accounts and assign
subscription licenses for Dynamics 365 (and other Office 365 apps such as Skype, Power BI and SharePoint).
Box 2: Dynamics 365 system administrator
The Dynamics 365 system administrator may assign roles and permissions to the Dynamics 365 user within an instance of Dynamics 365. The Dynamics 365
system administrator also controls all the settings in Dynamics 365.
Box 3: Dynamics 365 admin
The Dynamics 365 admin can perform backups and restores. Reference:
https://docs.microsoft.com/en-us/power-platform/admin/use-service-admin-role-manage-tenant
https://community.dynamics.com/crm/b/govandthecity/posts/understanding-dynamics-365-and-office-365-admi
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NEW QUESTION 165
- (Exam Topic 3)
You create a new solution for a business process.
The business process includes uploading specific file types to a web service.
You need to ensure that the business process works the same way anywhere the solution is deployed. Which option should you use? To answer, drag the
appropriate options to the correct configurations. Each
option may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Solution system settings
For Power Apps in Settings > Customizations > Customize the System you can configure email and document management, activate or deactivate processes, and
more.
Box 2: Environment variable
When should Environment variables be used? Some examples include:
When an input parameter needs to change across environments and should not be hard-coded. For example, a URL that points to a different resource in
development and production environments.
If you’re building a solution where your customer is required to provide an input value. Application setup pages.
Incorrect:
A connection reference is a solution component that contains information about a connector. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/advanced-navigation https://powerapps.microsoft.com/en-us/blog/environment-variables-
available-in-preview/

NEW QUESTION 166
- (Exam Topic 3)
A company has a sales application that is supported by an Azure SQL database. You are developing a Power Apps app for use by customer service agents.
The app must reference customer data from the sales application. Data in the sales application is constantly changing and must not be replicated in Microsoft
Dataverse
Some customer data is considered sensitive. You must protect data for specific fields when users view data in the app.
You need to configure table creation for the app.
How should you configure the app? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 168
- (Exam Topic 3)
You are a Dynamics 365 Customer Service help desk administrator.
Cases entered in forms require different types of data to be stored in different types of fields. You need to create forms for each of the following case types:

Which form types should you create? To answer, drag the appropriate form types to the meet the data entry requirements. Each source may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/dynamics365/customer-service/create-design-forms-customer-service-hub

NEW QUESTION 173
- (Exam Topic 3)
You have a business process flow (BPF) that interacts with the Account entity. You configure a new version for the BPF and add a new stage at the beginning.
You need to identify the impact of the new version on the existing account records.
What is the outcome in each scenario? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text Description automatically generated
Box 1: Existing accounts show the new BPF.
When an entity record is being created and if there are multiple BPFs defined on that entity. The system would do the following:
If the ProcessId field is set to Guid.Empty. The system will skip defaulting the BPF on that instance.
If the ProcessId field is set to specific BPF entity reference. The system will default to the specified BPF. If the ProcessId field on the record is not set. The system
will default the BPF.
Box 2: No BPF is linked to a new account.
Note: A business process flow definition is represented as a custom entity and an instance of a process is stored as a record within that entity. Each record is
associated with a data record (such as an Account, Contact, Lead, or Opportunity) and in case of cross-entity processes, with a data record for each participating
entity.
Reference:
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/business-process-fl

NEW QUESTION 178
- (Exam Topic 3)
You create a canvas app for a sales team. The app has an embedded Power BI tile that shows year-to-date sales. Sales users do not have access to the data
source that the tile uses.
Sales team users must be able to see data in the Power BI tile. You must minimize the level of permissions that you grant and minimize administrative overhead.
You need to share another Power BI component to make the data visible. What should you share?

A. The Power Bl dataset the tile uses as a data source.
B. The Power Bl workspace that includes the tile.
C. The Power Bl dashboard that includes the tile.

Answer: C

Explanation: 
Once shared, the PowerApps app will be accessible by all users who have permissions to access the app. However, in order to make the Power BI content visible
to those users, the dashboard where the tile comes from needs to be shared with the user on Power BI. This ensures that Power BI sharing permissions are
respected when Power BI content is accessed in an app.
Reference:
https://powerapps.microsoft.com/en-us/blog/power-bi-tile-in-powerapps/

NEW QUESTION 180
- (Exam Topic 3)
A car dealership has a Dynamics 365 Sales environment for its sales company and another environment for its leasing company. Users in one environment must
not be able to see the other environment. You need to grant salespeople access to the sales company environment. What should you do?

A. Add salespeople to a security role.
B. Set privileges.
C. Add salespeople to an Office 365 security group.
D. Set app security

Answer: C

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/control-user-access

NEW QUESTION 184
- (Exam Topic 3)
You are creating Power BI reports for a company.
A company that has a model-driven app wants to use Power BI reports within the app. You create the reports. You need to ensure that these reports are available
within the app.
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Which two actions should you perform? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Share the Power Bl report to all users.
B. Add the Power Bl report to the Site Map dashboards.
C. Create a PCF file.
D. Use the native reports in model-driven apps.
E. Add the Power Bl report to a dashboard in the model-driven app.

Answer: BE

Explanation: 
Reference: https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/add-powerbi-visual 

NEW QUESTION 185
- (Exam Topic 3)
A company uses a model-driven app for customer support. The company has the following requirements for the app:
• Send an email in real-time to customers when they enter their email address.
• Send an email to customers at the same time every day for cases that are open for more than 24 hours. The solution should require the least amount of
customization.
You need to configure the model-driven app. Which components should you use?

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 188
- (Exam Topic 3)
You create a Power Automate flow as part of a managed solution. The flow alerts users when files are uploaded to a SharePoint location.
Files are uploaded to SharePoint at a much higher rate than expected. Users report that they receive too many notifications about uploaded files.
You need to stop the flow and correct the issue.
What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated
Reference:
https://docs.microsoft.com/en-us/power-automate/edit-solution-aware-flow https://docs.microsoft.com/en-us/power-automate/error-checker

NEW QUESTION 193
- (Exam Topic 3)
A company plans to implement AI Builder to add intelligence to several business processes. Each business process uses different sources and produces different
outputs.
You need to determine which AI Builder model types to use.
Which model types should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/ai-builder/form-processing-model-overview https://docs.microsoft.com/en-us/ai-builder/entity-extraction-overview

NEW QUESTION 194
- (Exam Topic 3)
You manage the Dynamics 365 environment for a company.
You need to ensure that there are no leads for a customer before you create a new opportunity for the customer.
How can you use duplicate detection rules to achieve this goal? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 196
- (Exam Topic 3)
You have a canvas app with an embedded Power Bl tile.
You share the canvas app. Users report that they are unable to access the Power Bl content. You need to determine why users are unable to access the content
What is the cause of the user s problems?

A. The Power Bl dashboard is not shared.
B. The Power Bl interactions property on the Power Bl tiles is set to Off.
C. The Power Bl connection is not shared.
D. The Power Bl Display mode property on the Power Bl tiles is set to Disabled

Answer: A

Explanation: 
When embedding a Power BI tile in a Canvas app, there are several factors that must be considered in order to ensure that users have access to the content. One
of the most important is sharing the Power BI dashboard that the tile is embedded in. If the dashboard is not shared with the users, they will not be able to view the
content in the tile.
To share a Power BI dashboard, you must have the "Edit" permission for the dashboard. Once you have this permission, you can share the dashboard with other
users by following these steps:

Click the "Share" button in the top-right corner of the dashboard.

 In the "Share" pane that appears, enter the email addresses of the users that you want to share the dashboard with.

 Select the level of access that you want to grant to the users. You can choose to give them "View" access, which allows them to view the dashboard but not
make changes, or "Edit" access, which allows them to view and make changes to the dashboard.

 Click the "Share" button to share the dashboard with the users. Additionally, there are other factors that could cause user's problems:

 B. The Power Bl interactions property on the Power Bl tiles is set to Off. In that case, the user's won't be able to interact with the visuals.

 C. The Power Bl connection is not shared. In that case, the user's won't have the access to the data source

 D. The Power Bl Display mode property on the Power Bl tiles is set to Disabled, in that case the user's won't see the tile
It is important to check all of these factors and ensure that they are properly configured in order to ensure that users have access to the content.
References:

 https://docs.microsoft.com/en-us/power-bi/service-admin-share-dashboard

 https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/embed-power-bi
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 https://docs.microsoft.com/en-us/power-bi/service-embed-content/embed-in-powerapps

NEW QUESTION 201
- (Exam Topic 3)
You are a Dynamics 365 Customer Service administrator.
A user must be able to view system posts and activities in a dashboard. You need to create the dashboard for the user.
Which components should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated
Box 1: Timeline
The timeline helps agents see all customer interaction history across channels, personnel, and the support lifecycle. The timeline is used across Dynamics 365
applications to capture activities like notes, appointments, emails, tasks, and more, to ensure that all interactions with the customer are tracked and visible over
time. Agents use the timeline to quickly catch up on all of the latest activity details with the customer to provide the most personalized support experience.
Box 2: Lists Reference:
https://docs.microsoft.com/en-us/dynamics365/customer-service/customer-service-hub-user-guide-timeline-adm

NEW QUESTION 205
......
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